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PHẦN 1. MỞ ĐẦU 
 

1. Lý do chọn chuyên đề 

Hiện nay, Bộ Giáo dục và Đào tạo triển khai đồng bộ các giải pháp thực hiện 

chương trình giáo dục phổ thông theo hướng phát triển năng lực, phẩm chất; chú 

trọng giáo dục lòng yêu nước, truyền thống, đạo đức, lối sống cho người học. 

Năm học 2020 - 2021, chương trình GDPT 2018 chính thức được triển khai. 

Với quan điểm xây dựng chương trình mở và có tính linh hoạt, giáo viên được trao 

quyền tự chủ trong việc điều chỉnh, xây dựng chương trình, kế hoạch dạy học phù 

hợp đối tượng học sinh lớp mình, với đặc điểm của nhà trường và địa phương. 

Song song với đổi mới chương trình là đổi mới hình thức kiểm tra đánh giá 

kết quả giáo dục theo hướng đánh giá năng lực, phẩm chất người học được chỉ rõ 

tại Thông tư số 27/2020/TT-BGDĐT, ngày 04/9/2020 của Bộ GD&ĐT ban hành 

quy định đánh giá học sinh tiểu học góp phần thúc đẩy mạnh mẽ việc đổi mới 

phương pháp dạy học. Dạy học theo hướng phát huy tính tích cực, chủ động, sáng 

tạo của học sinh là nhiệm vụ cơ bản nhằm mục đích thay đổi “cách dạy” của giáo 

viên; “cách nghĩ, cách học” của học sinh.  

Đáp ứng yêu cầu đó, mỗi nhà trường, mỗi giáo viên cần phát huy tối đa tính 

tích cực, chủ động, tự giác của học sinh. Hiện nay có rất nhiều phương pháp dạy 

học mới, các kĩ thuật dạy học tích cực (KTDHTC) đang được triển khai nhằm nâng 

cao chất lượng giáo dục. Học sinh được chia sẻ những kiến thức và kinh nghiệm 

không chỉ từ phía thầy cô mà từ chính bản thân và bạn bè xung quanh. Học sinh sẽ 

thấy vui, hào hứng khi được sáng tạo, thể hiện. Từ đó các em ghi nhớ sâu kiến thức 

và vận dụng linh hoạt vào cuộc sống hàng ngày. 

Hiện nay các KTDHTC được vận dụng nhiều trong thực tế như kĩ thuật động 

não, kĩ thuật thông tin phản hồi, kĩ thuật bể cá, kĩ thuật tia chớp, kĩ thuật khăn trải 

bàn, kĩ thuật ổ bi, kĩ thuật mảnh ghép, kĩ thuật sơ đồ tư duy,... Trong đó, dạy học 

bằng Sơ đồ tư duy (SĐTD) là một kĩ thuật dạy học được ứng dụng rất nhiều và 

mang lại hiệu quả. 

Ngày 10 tháng 6 năm 2022, trong bài phát biểu tại cuộc thi Sơ đồ tư duy do 

VTV tổ chức, tiến sĩ Thái Văn Tài, vụ trưởng vụ Giáo dục Tiểu học, Bộ Giáo dục 

và Đào tạo đã chia sẻ về lợi ích của kĩ thuật dạy học sơ đồ tư duy. Theo ông, sơ đồ 

tư duy “là kĩ thuật, phương pháp dạy học cần được chú ý thực hiện để phát huy 

hiệu quả trong thời gian tới”.  

Dạy học theo sơ đồ tư duy hiện nay đang hướng đến tối ưu hóa kĩ thuật dạy 

học và tích cực hóa cá nhân, giúp các em học sinh có cơ hội tiếp cận với phương  
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pháp học mới. 

Môn học chiếm nhiều thời lượng nhất trong chương trình các lớp ở tiểu học 

đó là Tiếng Việt - một môn sử dụng nhiều “kênh chữ”, khó và ngại với học sinh. 

Vậy làm thế nào để học sinh không phải tiếp nhận thông tin một cách thụ động mà 

trái lại, các em phải động não và ghi nhớ một cách sáng tạo, logic những kiến thức 

đã học? Kiến thức cần ghi nhớ về từ và câu, viết văn và cả nội dung, ý nghĩa các 

câu chuyện, bài thơ, bài văn trong phân môn đọc được hệ thống một cách khoa 

học?  

Để giúp học sinh dễ nhớ và nhớ lâu, kích thích hứng thú học tập của các em, 

sử dụng sơ đồ tư duy chính là một kĩ thuật dạy học tích cực đạt hiệu quả. Học tập 

bằng sơ đồ tư duy sẽ giúp các em nắm tri thức một cách có hệ thống, dễ nhớ, hình 

thành cho học sinh tư duy mạch lạc, hiểu biết vấn đề một cách khoa học, sâu sắc. 

Các em không chỉ học tốt các kiến thức trong sách vở mà còn nắm bắt được các 

kiến thức từ thực tế cuộc sống. Các nhánh với sự kết hợp hài hòa của chữ viết, hình 

ảnh, đường nét, màu sắc sẽ kích thích học sinh tìm tòi, đào sâu, mở rộng thêm ý 

tưởng của chủ đề chính một cách chi tiết, sáng tạo và thăng hoa. 

Sơ đồ tư duy hiệu quả là vậy nhưng thực tế, một bộ phận giáo viên chưa hiểu 

sâu, ngại áp dụng vào giảng dạy. Một số giáo viên đã áp dụng song còn lúng túng, 

mang tính hình thức, chưa khai thác triệt để các thế mạnh của kĩ thuật này. Bên 

cạnh đó, học sinh học tập một cách thụ động, máy móc theo khuôn khổ, chưa biết 

cách tư duy. Các em chỉ học gì biết đó chưa có sự liên hệ giữa các mạch kiến thức 

nên chưa tư duy logic, hệ thống.  

Xác định được vị trí, vai trò và tầm quan trọng của SĐTD trong việc góp 

phần nâng cao hiệu quả, chất lượng dạy học, chúng tôi lựa chọn nghiên cứu chuyên 

đề Áp dụng kĩ thuật dạy học Sơ đồ tư duy trong dạy viết đoạn văn miêu tả, Tiếng 

Việt 3, CTGDPT 2018. 

2. Mục tiêu, nhiệ   ụ c a chuyên đề 

- Giới thiệu tổng quan về kĩ thuật dạy học sơ đồ tư duy. 

- Chia sẻ cấu tạo và các bước thiết kế sơ đồ tư duy. 

- Định hướng vận dụng kĩ thuật sơ đồ tư duy trong thực tế dạy viết đoạn văn 

miêu tả, Tiếng Việt 3, bộ sách Kết nối tri thức với cuộc sống, CTGDPT 2018.  

 

 

 



4 

PHẦN 2. NỘI DUNG 

1. Thực trạng dạy học sử dụng sơ đồ tư duy 

1.1. Ưu điểm 

Trong các bộ sách giáo khoa, nhiều tác giả đã sử dụng sơ đồ tư duy giúp học 

sinh hình thành, thực hành vận dụng kiến thức đáp ứng yêu cầu của tiết học. Các sơ 

đồ tư duy được trình bày khoa học, đa dạng cùng các hình vẽ minh họa đẹp, sinh 

động, giúp học sinh hứng thú học tập, có cái nhìn tổng quát, dễ nhớ, dễ thuộc. 

Hiện nay rất nhiều nhà trường của các tỉnh thành đã áp dụng kĩ thuật sơ đồ tư 

duy trong giảng dạy và mang lại hiệu quả thiết thực. Giảng dạy theo sơ đồ tư duy 

mang tính khả thi cao vì có thể vận dụng được với bất kỳ điều kiện cơ sở vật chất 

của các nhà trường. Có thể thiết kế trên giấy, bìa, bảng bằng cách sử dụng bút chì 

màu, phấn màu đơn giản hoặc cũng có thể thiết kế trên phần mềm tạo SĐTD. 

Với môn Tiếng Việt, sơ đồ tư duy được sử dụng cho các bài tập và viết đoạn 

văn, đặc biệt là giai đoạn lên ý tưởng. Sơ đồ tư duy được áp dụng để hình dung, 

tạo, sắp xếp, liệt kê các suy nghĩ và ý tưởng, là phương thức phù hợp để khuyến 

khích, tăng hứng thú học tập, khơi gợi niềm yêu thích thay bằng những con chữ 

khô khan, đơn điệu, khắc phục tình trạng sao chép văn mẫu của học sinh. Nhờ sơ 

đồ tư duy, các em nhìn thấy được bức tranh tổng thể về những kiến thức, đâu là 

trọng tâm, đâu là các ý chính, ý phụ giúp các em ghi nhớ và viết đoạn văn tốt hơn. 

Thay vì phải ghi chép các câu văn rất dài, học sinh chỉ cần tóm tắt các từ khóa một 

cách cô đọng, súc tích, vẫn đảm bảo kiến thức cần ghi nhớ. Từ đó học sinh dành 

thời gian tự nhận xét; nhận xét đánh giá và học tập câu văn hay, hình ảnh sinh động 

của bạn. Thông qua trao đổi, học sinh sẽ học ở bạn, tự sửa sai.  

1.2. Hạn chế 

- Một số giáo viên chưa mạnh dạn sử dụng các kĩ thuật dạy học tích cực do 

ngại thiếu thời gian vì đặc trưng các tiết viết văn dài, khô khan. 

- Một số giáo viên chưa có kĩ năng thiết kế sơ đồ tư duy nên việc khai thác 

các sơ đồ tư duy trong SGK một cách máy móc, chưa biết cách cùng HS xây dựng, 

tái hiện lại các sơ đồ. Thay vào việc cùng học sinh xây dựng các sơ đồ, dẫn dắt học 

sinh tham gia vào khai thác kiến thức trên sơ đồ, giáo viên đưa luôn ảnh chụp hoặc 

chỉ yêu cầu học sinh quan sát sơ đồ trong SGK, hoàn thành bài tập. 

- Trong giai đoạn đầu, hầu hết học sinh mới chỉ vẽ được sơ đồ tư duy đơn 

giản, chưa có hệ thống, chưa tương đồng về mạch kiến thức hay học sinh vẽ được 

sơ đồ tư duy nhưng các em mới liệt kê được một số ý, sắp xếp còn lộn xộn, 

không đầy đủ, chưa logic. 
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- Học sinh chưa được làm quen nhiều với SĐTD nên chưa có kĩ năng xây 

dựng, chưa có thói quen chia sẻ, sơ đồ còn đơn điệu, vẽ các hình ảnh chưa thể hiện 

sự sáng tạo. 

2. Tổng quan  ề kĩ thuật dạy học Sơ đồ tư duy 

2.1. Khái niệm 

SĐTD tên tiếng Anh là Mindmap được biết đến là phương pháp ghi chú 

thông minh với các ý tưởng sử dụng từ ngữ ngắn gọn cùng hình ảnh sinh động để 

bộ não con người có thể tiếp cận, ghi nhớ một cách nhanh chóng và lưu trữ lâu dài. 

Sơ đồ tư duy là một công cụ tổ chức tư duy được tác giả Tony Buzan (người 

Anh) nghiên cứu kĩ lưỡng và chia sẻ khắp trên thế giới. Thông thường, chúng ta ghi 

chép thông tin bằng các ký tự, đường thẳng, con số. Với cách ghi chép đó, chúng ta 

mới chỉ sử dụng một nửa của bộ não - não trái, mà chưa sử dụng kĩ năng bên não 

phải, nơi giúp chúng ta xử lý các thông tin về nhịp điệu, màu sắc, không gian… và 

cách ghi chép thông thường khó nhìn được tổng thể của cả vấn đề. Sơ đồ tư duy 

giúp con người làm việc khoa học, sáng tạo, truyền tải thông tin vào bộ não một 

cách dễ dàng, đồng thời là phương tiện ghi chép hiệu quả, logic, mạch lạc trực 

quan, dễ nhìn, dễ hiểu, dễ nhớ vì nó được thể hiện bằng màu sắc, liên kết giữa các ý 

của vấn đề. Nhìn thấy "bức tranh" tổng thể mà lại chi tiết, dễ dạy, dễ học, dễ nhớ, 

kích thích hứng thú học tập của học sinh. 

2.2. Cấu tạo và các bước thiết kế một sơ đồ tư duy 

2.2.1. Cấu trúc một sơ đồ tư duy 

- Phần chủ đề (nội dung chính); 

- Các nhánh chính (triển khai chủ đề); 

- Các nhánh phụ (triển khai nhánh chính); 

- Phần kí hiệu, biểu tượng, tranh ảnh,… kèm theo để làm cho chủ đề thêm 

sinh động, dễ hình dung, liên tưởng. 

2.2.2. Các bước thiết kế một sơ đồ tư duy 

Bước 1. Xác định chủ đề 

Bước 2. Vẽ chủ đề ở phần trung tâm 

Chủ đề cần gây được sự chú ý để chúng ta có thể dễ dàng nhìn nhận vấn đề, 

vì thế nên chủ đề cần vẽ to và nổi bật. 

Bước 3. Vẽ thêm các tiêu đề phụ (nhánh cấp 1) 

- Tiêu đề phụ nên được viết bằng chữ in hoa nằm trên các nhánh dài để làm 

nổi bật. 
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- Tiêu đề phụ nên gắn liền với trung tâm. 

- Tiêu đề phụ nên được vẽ theo hướng chéo góc chứ không nằm ngang, như 

vậy nhiều nhánh phụ khác có thể được vẽ tỏa ra một cách dễ dàng hơn. 

Bước 4. Vẽ các nhánh cấp 2, cấp 3,… 

- Vẽ nối tiếp nhánh cấp 2 vào nhánh cấp 1, nhánh cấp 3 vào nhánh cấp 2,… 

để tạo sự liên kết. 

- Nên vẽ nhiều nhánh cong hơn là đường thẳng, tạo sự mềm mại, uyển 

chuyển và dễ nhớ hơn. 

- Tận dụng từ khóa và hình ảnh, ở mỗi nhánh chỉ sử dụng một từ khóa. 

- Dùng biểu tượng, cách viết tắt để tiết kiệm không gian và thời gian. 

Bước 5. Thêm các hình ảnh minh họa 

Việc thêm các hình ảnh minh họa vào sơ đồ giúp các ý quan trọng trở nên 

nổi bật hơn, cũng như giúp chúng ta ghi nhớ tốt hơn vì não bộ của con người có 

khả năng tiếp thu hình ảnh cao hơn chữ viết. 

3. Nghiên cứu sơ đồ tư duy trong dạy học chương trình GDPT 2018. 

3.1. Sơ đồ tư duy trong chương trình GDPT 2018 

Qua khảo sát chương trình GDPT 2018, chúng tôi nhận thấy các bộ SGK 

Chân trời sáng tạo, Cánh diều, Kết nối tri thức và cuộc sống,… có rất nhiều các bài 

học, môn học và hoạt động giáo dục ở các lớp 1, 2, 3 sử dụng sơ đồ tư duy. Trong 

nội dung các môn học và hoạt động giáo dục: Tiếng Việt, Tự nhiên & xã hội, Đạo 

đức, Tin học, Công nghệ và Hoạt động trải nghiệm nhiều bài học được thiết kế 

bằng sơ đồ tư duy cụ thể, sinh động giúp HS hứng thú học tập và phát triển tư duy.  

 Ví dụ: 

 

Chủ đề 2. Tuần 6. Nét riêng của em, HĐTN 3, trang 20 (Cánh Diều) 
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Bài 30. Phòng, tránh bị xâm hại, môn Đạo đức 1, trang 69 

 

Bài 4. Viết đoạn văn kể lại hoạt động đã làm cùng người thân, TV3, trang 25 
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Bài 6. Truyền thống trường em, TN&XH 3, trang 29 

 

 

Bài 28. Viết đoạn văn kể lại việc làm góp phần bảo vệ môi trường, TV3, trang 125 
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3.2. Một số địa chỉ khai thác, sử dụng sơ đồ tư duy trong chương trình 

môn Tiếng Việt 3 

CÁC TIẾT DẠY SỬ DỤNG SƠ ĐỒ TƯ DUY 

(Tiếng Việt 3, Bộ sách Kết nối tri thức với cuộc sống) 
 

STT TUẦN BÀI NỘI DUNG TRANG 

1 2 4 
Viết đoạn văn kể lại hoạt động đã làm cùng 

người thân 
25 

2 5 10 
Viết đoạn văn nêu tình cảm, cảm xúc đối 

với một người mà em yêu quý 
48 

3 8 16 Viết thông báo 72 

4 10 18 Viết đoạn văn tả đồ vật 88 

5 13 24 Viết đoạn văn tả đồ vật 109 

6 19 2 
Viết đoạn văn kể lại diễn biến của một hoạt 

động ngoài trời 
12 

7 20 4 
Viết đoạn văn kể lại hoạt động quan sát 

được trong tranh 
21 

8 21 6 
Viết đoạn văn nêu tình cảm, cảm xúc về 

cảnh vật trong tranh 
29 

9 29 20 
Viết đoạn văn nêu tình cảm, cảm xúc về 

một cảnh đẹp của đất nước 
94 

10 30 22 
Viết đoạn văn nêu lí do yêu thích một nhân 

vật trong câu chuyện đã học, đã nghe 
101 

11 33 28 
Viết đoạn văn kể lại một việc làm góp 

phần bảo vệ môi trường 
125 

12 34 29 Nói và nghe: Người nổi tiếng 128 

13 35  Ôn tập và đánh giá cuối học kì 2 138 

 

4. Hướng dẫn giáo  iên sử dụng phần  ề  Imindmap 10 thiết kế sơ đồ 

tư duy 
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Áp dụng kĩ thuật sơ đồ tư duy hiệu quả, giáo viên cần trang bị, rèn cho mình 

kĩ năng thiết kế sơ đồ tư duy nhanh, sinh động với những kiểu dáng, hình ảnh, màu 

sắc đa dạng, cuốn hút học sinh. 

4.1. Cách cài đặt phần mềm Imindmap 10 trên máy tính 

Bước 1: Truy cập vào website download.vn và tìm kiếm từ khóa Imindmap 

10 sau đó chọn Tải về. 
 

 

Bước 2: Chọn một link để tải về, ở Download.vn bạn sẽ thấy được những 

phiên bản đầy đủ của tất cả những phần mềm trên Internet. 

 
 

Bước 3: Khi tải xong file cài đặt bạn hãy bấm vào file cài đặt của Imindmap 

để bắt đầu tiến hành cài đặt. 
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Chọn ngôn ngữ cài đặt của phần mềm và bấm OK. 

 

Bước 4: Cửa sổ cài đặt sẽ hiện ra, bấm Next để tiếp tục. 
 

 
 

Ở cửa sổ Choose a file location bạn có thể thay đổi đường dẫn file cài đặt 

bằng cách bấm vào Browse... để thay đổi, hoặc để mặc định theo nhà sản xuất sau 

đó bấm Next. 



12 

 

Bước 5: Chọn ổ cứng muốn chứa Imindmap và bấm Select Folder. 

 

Đến cửa sổ này thì bạn hãy bấm Install để thực hiện cài đặt. 

 
 

Chờ một chút để quá trình cài đặt được diễn ra. 
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Bước 6: Sau khi có thông báo cài đặt thành công, bấm vào Run 

iMindMap để chạy phần mềm. 

 
 

4.2. Cách vẽ sơ đồ tư duy trong Imindmap 10 

Bước 1. Tạo  ột Central idea (ý tưởng trung tâm) 

Trên giao diện chính của Imindmap các bạn chọn File -> New -

> Mindmap -> chọn biểu tượng cho central idea -> Start. 
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Sau khi chọn một Central idea thì trên giao diện xuất hiện Central idea các 

bạn vừa chọn, tiếp theo các bạn nhấp đúp chuột trái và thay đổi nội dung, font, cỡ 

chữ, kiểu chữ theo ý muốn. 

Bước 2. Thê  các nhánh 

Imindmap gồm hai loại nhánh là Branch (nhánh trơn) và BoxBranch (nhánh 

có hộp văn bản đi kèm). Các bạn có thể thêm nhánh bằng cách nhấn chọn Central 

idea xuất hiện hai biểu tượng dấu +, các bạn chọn dấu cộng và chọn kiểu nhánh các 

bạn muốn thêm. 

 

 

Hoặc các bạn chọn Central idea và chọn thẻ Insert -> Branch -> Child (nếu 

muốn thêm một nhánh trơn). Chọn Insert -> Box -> Child (nếu muốn thêm một 

nhánh chứa hộp văn bản). 

Để di chuyển nhánh các bạn nhấn chọn nhánh cần di chuyển, xuất hiện biểu 

tượng mũi tên bốn chiều như hình dưới, các bạn nhấn giữ chuột trái vào biểu tượng 

đó và kéo nhánh đến vị trí cần thiết thì nhả con trỏ chuột ra. 

 

 

Để thay đổi kiểu của nhánh các bạn chọn nhánh -> Branch -> Branch Art, 

xuất hiện hộp thoại Branch Art, chọn kiểu cho nhánh và nhấn OK để thay đổi. 
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Nếu các bạn muốn thay đổi hình hộp chứa văn bản của nhánh chứa hộp văn 

bản thì các bạn chọn hộp văn bản và chọn biểu tượng Shape. Sau đó lựa chọn hình 

các bạn muốn. 

 

 

Bước 3. Thê  từ khóa 

Với nhánh có hộp văn bản thì các bạn nhấn chọn chuột vào hộp văn bản và 

nhập từ khóa, chỉnh sửa font, kiểu chữ và cỡ chữ cho nhánh. Còn với nhánh trơn 

các bạn nhấn chọn nhánh và nhập từ khóa, chỉnh sửa font, kiểu chữ và cỡ chữ cho 

nhánh. 

 

 

Bước 4. Chọn  ã  àu cho các nhánh 

Thay đổi màu sắc cho nhánh các bạn chọn nhánh -> Branch -> Branch 

Color, xuất hiện hộp thoại Branch Color Picker các bạn chọn màu sắc cho nhánh 

và nhấn OK để thay đổi. 
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Bước 5. Thê  các hình ảnh 

Để sơ đồ sinh động hơn, dễ tư duy hơn thì các bạn có thể thêm các hình ảnh 

mô tả ý tưởng của nhánh bằng cách nhấn chọn biểu tượng Images ở menu phía bên 

phải hoặc chọn Insert -> Image Library để mở hộp thoại Image Library. 

 

 
 

Tại đây các bạn có thể tìm hình ảnh trong thư viện của Imindmap bằng cách 

nhập từ khóa hình ảnh cần tìm trong ô Search the image library và nhấn Enter để 

tìm kiếm. Sau đó chọn hình ảnh các bạn cần thêm vào sơ đồ. 
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Nếu các bạn muốn thêm hình ảnh trên máy tính thì các bạn chọn Browse và 

chọn đến file ảnh mà bạn muốn chèn. 

 

 

Để di chuyển hình ảnh các bạn nhấn giữ chuột trái và kéo hình ảnh đến vị trí 

cần đặt. Để phóng to, thu nhỏ hình ảnh các bạn thực hiện như phóng to, thu nhỏ 

central idea. 

Bước 6. Xuất file 

Cuối cùng, sau khi đã hoàn tất sơ đồ tư duy các bạn có thể xuất sơ đồ ra file 

ảnh, document, chia sẻ qua web… bằng cách chọn File -> Export & Share. Xuất 

hiện hộp thoại Export các bạn có thể chọn kiểu xuất và làm theo hướng dẫn để 

nhanh chóng xuất file hoặc chia sẻ file. 

 

5. Sử dụng sơ đồ tư duy trong quá trình tổ chức dạy viết đoạn  ăn  iêu 

tả, Tiếng Việt 3, chương trình GDPT 2018 

5.1. Giáo viên hướng dẫn học sinh khai thác, mở rộng các sơ đồ tư duy 

được thiết kế trong SGK. 

Khai thác, mở rộng các sơ đồ tư duy được thiết kế trong sách giáo khoa, giáo 

viên cần làm tốt một số việc sau: 

- Nghiên cứu kĩ nội dung bài dạy, ý đồ của SGK và ý nghĩa của sơ đồ. 
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- Sử dụng hệ thống câu hỏi vấn đáp hoặc tổ chức thảo luận nhóm để xây 

dựng sơ đồ tư duy theo gợi ý SGK. 

- Mở rộng các nhánh của sơ đồ tư duy, phát triển các ý sáng tạo cho học sinh. 

Ví dụ: Bài 24. Luyện tập: Viết đoạn văn tả đồ vật (Bài 2, trang 110, SGK, 

TV3, tập 1) 

Khi dạy bài luyện tập này, đối với bài tập 2, GV nắm được các yêu cầu cần 

đạt, cụ thể: 

- Kiến thức: HS viết được đoạn văn tả đồ vật theo gợi ý. 

- Năng lực:  

+ HS phát triển năng lực giải quyết vấn đề và sáng tạo: trả lời các câu hỏi, vẽ 

được sơ đồ tư duy về đoạn văn tả đồ vật. 

+ Năng lực giao tiếp và hợp tác: Tham gia làm việc nhóm trong các hoạt 

động học tập. 

Về ý đồ của SGK và ý nghĩa của sơ đồ: Cung cấp cho học sinh sơ đồ với các 

gợi ý. Từ đó học sinh làm điểm tựa phát triển các ý viết thành đoạn văn hoàn chỉnh. 

Nhờ có sơ đồ này HS dễ ghi nhớ các ý, sắp xếp các ý theo một trình tự hợp lí. 

Thông qua hệ thống câu hỏi, GV cùng HS xây dựng được sơ đồ như SGK đã 

gợi ý: 

+ Em chọn tả đồ vật nào? (gấu bông, hộp bút,...) 

+ Khi tả đồ vật, em sẽ tả những gì? (Đặc điểm của các bộ phận, công dụng 

của đồ vật, suy nghĩ của em về đồ vật,...) 

+ Ngoài tả đặc điểm, công dụng, suy nghĩ, các em có thể tả thêm những gì? 

(Phát huy khả năng của đối tượng HS năng khiếu) 

Dựa trên sự mở rộng, kích thích năng lực vận dụng, sáng tạo với các đối 

tượng HS, GV mở rộng thêm các nhánh “câm” để các đối tượng HS sáng tạo, phát 

huy phù hợp với năng lực cá nhân. 

Khi đó từ sơ đồ sẵn có, GV có thể sáng tạo, mở rộng như sau: 
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5.2. Hướng dẫn HS thiết kế sơ đồ tư duy trong viết đoạn văn miêu tả, 

Tiếng Việt 3, CTGDPT 2018 

5.2.1. Quy trình sử dụng sơ đồ tư duy trong tổ chức dạy - học 

* Hoạt động 1: Xác định chủ đề 

Học sinh đọc kĩ đề bài, tìm hiểu đề, xác định chủ đề. Khi đọc đề bài, cần phải 

xác định rõ đối tượng được yêu cầu trong đề.  

Ví dụ: Bài 4. Luyện tập: Viết đoạn văn kể lại hoạt động đã làm cùng người 

thân (Bài tập 2, trang 25, SGK, TV3, tập 1) 

Đối tượng yêu cầu trong bài là hoạt động đã làm cùng người thân. Giáo viên 

nên hướng dẫn những hoạt động mà học sinh thường làm và có ấn tượng sâu sắc. 

Có như vậy khi học sinh kể lại sẽ dễ dàng và bộc lộ được cảm xúc chân thật nhất. 

Ví dụ: Bài 10. Luyện tập: Viết đoạn văn nêu tình cảm, cảm xúc đối với một 

người mà em yêu quý (Bài tập 1, trang 49, SGK, TV3, tập 1) 

Đối tượng yêu cầu trong bài là tình cảm, cảm xúc đối với một người mà em 

yêu quý. Trước hết giáo viên nên hướng dẫn học sinh chọn một người mà em yêu 

quý nhất (có thể là bố, mẹ, cô giáo hoặc người bạn,…). Ngay từ hoạt động này GV 

cần gợi ý HS chọn lựa kĩ càng tránh trường hợp bắt chước các bạn, khi bắt tay vào 

tả lại thay đổi. Lựa chọn kĩ đối tượng học sinh sẽ dễ dàng liên tưởng, bộc lộ cảm 

xúc chân thành về người em đã chọn tả. 

* Hoạt động 2: Vẽ sơ đồ đồ tư duy theo mạch tư duy.  

Ví dụ: Bài 24. Luyện tập: Viết đoạn văn tả đồ vật (Bài tập 1, trang 110, 

SGK, TV3, tập 1) 

Đối với chủ đề này GV hướng dẫn học sinh thực hiện theo 5 bước như sau: 

Bước 1. Xác định chủ đề 

- Yêu cầu học sinh đọc đề. 

- Bài văn tả đồ vật gì? (Tả cái đồng hồ) 

Bước 2. Vẽ chủ đề ở phần trung tâm 

Hướng dẫn học sinh vẽ hình làm trung tâm ghi tên đồ vật hoặc dùng hình 

ảnh, tranh vẽ đồng hồ. 

Bước 3. Vẽ thêm các tiêu đề phụ (nhánh cấp 1) 

* Yêu cầu học sinh vẽ thêm các nhánh để triển khai chủ đề 

- Bài văn tả những chi tiết nào của đồng hồ? (tả các bộ phận của đồng hồ; tả 

âm thanh của đồng hồ…) 
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- Như vậy học sinh sẽ vẽ 2 nhánh cấp 1 từ chủ đề trung tâm. 

Bước 4. Vẽ các nhánh phụ (nhánh cấp 2, cấp 3) 

- GV gợi ý bằng câu hỏi: 

+ Tác giả tả những bộ phận nào của đồng hồ? (vỏ đồng hồ, kim đồng hồ,...) 

+ Tác giả tả những âm thanh nào của đồng hồ? (tiếng kim của đồng hồ chạy, 

tiếng chuông của đồng hồ,…) 

- GV mở rộng thêm các nhánh của sơ đồ tư duy để phát huy tính sáng tạo của 

học sinh. Ví dụ như: 

+ Ngoài miêu tả các bộ phận, âm thanh của đồng hồ tác giả còn tả và kể 

thêm những gì? (Giới thiệu lí do có đồng hồ, công dụng của đồng hồ, suy nghĩ của 

tác giả về đồ vật đó) 

+ Để miêu tả hai cái kim tác giả sử dụng biện pháp nghệ thuật gì? (biện pháp 

so sánh,…) Câu văn nào thể hiện điều đó? (Đồng hồ nhà tôi … sau đêm mưa) 

+ Suy nghĩ của em về đồ vật đó? (tình cảm, cách bảo quản, ...) 

- Như vậy học sinh sẽ vẽ tiếp nhánh 2 từ các nhánh 1. 

Bước 5. Thêm các hình ảnh minh họa 

- Giáo viên gợi ý để học sinh có thể dán hoặc vẽ những hình ảnh minh họa. 

Thay vì học sinh chỉ ghi tên chủ đề khô khan giáo viên hướng các em vẽ tranh với 

hình ảnh sinh động, màu sắc đa dạng phong phú từ đó tạo cảm giác thích thú, say 

mê với giờ học viết văn. 

Ví dụ: Các em vẽ hình ảnh các đồ vật như cặp sách, quả bóng, gấu bông,...  

Trên cơ sở những gợi ý và việc tham gia xây dựng sơ đồ theo gợi ý của sách 

giáo khoa, học sinh dùng vốn hiểu biết, hình ảnh, màu sắc minh họa xây dựng sơ 

đồ tư duy theo ý tưởng của cá nhân. Học sinh thỏa sức sáng tạo theo hiểu biết và 

năng khiếu của bản thân đưa ra các sơ đồ phong phú, đầy chất sáng tạo. 
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* Hoạt động 3: Báo cáo, thuyết minh về sơ đồ tư duy  

Cho một vài học sinh hoặc đại diện của các nhóm học sinh lên báo cáo, 

thuyết minh về sơ đồ tư duy mà nhóm mình đã thiết lập. Qua hoạt động này, GV 

vừa biết rõ mức độ hiểu kiến thức của các em, vừa là một cách rèn cho các em khả 

năng thuyết trình trước đông người, giúp các em tự tin hơn, mạnh dạn hơn, đây 

cũng là một trong những điểm cần rèn luyện của học sinh hiện nay. 

* Hoạt động 4: Thảo luận, chỉnh sửa, hoàn thiện sơ đồ tư duy 

Tổ chức cho học sinh thảo luận, bổ sung, chỉnh sửa để hoàn thiện sơ đồ tư 

duy về kiến thức cần đạt của một đoạn văn. Giáo viên sẽ là người cố vấn, là trọng 

tài giúp học sinh hoàn chỉnh sơ đồ tư duy, từ đó dẫn dắt đến kiến thức trọng tâm 

của bài học. 

* Hoạt động 5: Củng cố kiến thức bằng sơ đồ tư duy 

Nhìn vào sơ đồ tư duy, học sinh lần lượt trình bày bài làm, nêu tình cảm của 

mình. HS chốt lại những kiến thức trọng tâm. 

* Hoạt động 6: Dựa trên sơ đồ tư duy, viết thành đoạn văn hoàn chỉnh 

Ví dụ: Bài 24. Luyện tập: Viết đoạn văn tả đồ vật (Bài tập 2, 3 trang 110, 

SGK, TV3, tập 1) 

Hoạt động 1:  

- GV cho học sinh đọc đề bài (Viết đoạn văn tả một đồ vật em yêu thích). 

- HS nêu đồ vật em chọn tả (HS nêu đồ vật và giơ ảnh vẽ đồ vật hoặc đồ vật 

thật mà GV đã dặn dò HS về nhà chuẩn bị trong hoạt động tiếp nối của tiết học 

trước). 

- Nếu học sinh chưa chọn được GV có thể gợi ý một số đồ vật cho HS chọn 

tả như cặp sách, hộp bút, đèn học, bút máy, lật đật, bút chì, … 
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Khi HS đã có sự chuẩn bị đồ vật các em yêu thích từ tiết học trước sẽ khơi 

gợi lòng yêu thích đồ vật, hứng thú khi tả về đồ vật, từ đó cách dùng từ, viết câu và 

đặc biệt là viết câu văn có hình ảnh so sánh sẽ dễ dàng hơn. 

 Hoạt động 2:  

- Trước khi vẽ sơ đồ tư duy GV có thể hỏi các em chọn tả đồ vật nào, sau đó 

GV thống kê các nhóm đồ vật mà HS trong lớp đã chọn tả, tổ chức cho HS di 

chuyển vị trí ngồi theo nhóm các em cùng chọn tả về một loại đồ vật. Như vậy khi 

viết đoạn văn và chia sẻ bài viết các em sẽ dễ dàng hỗ trợ cho nhau. 

- Tiếp đến, GV cho HS nêu những nội dung mà các em sẽ chọn tả về đồ vật 

của mình bởi mỗi em có thể chọn tả những đồ vật có đặc điểm khác nhau vì vậy nội 

dung các em vẽ trong sơ đồ có thể khác nhau, không nhất thiết phải theo một khuôn 

mẫu cố định như SGK.  

+ GV có thể đặt câu hỏi: Khi tả về đồ vật của mình, em sẽ tả những gì? (HS 

có thể trả lời: Em tả đặc điểm của các bộ phận, công dụng của đồ vật, suy nghĩ của 

em về đồ vật,…) + Sau đó GV có thể đưa câu hỏi (dành cho đối tượng HS năng 

khiếu): Ngoài tả đặc điểm, công dụng, suy nghĩ, các em có thể tả thêm những gì? 

(Giới thiệu đồ vật, tả âm thanh, ...) 

Cuối cùng GV có thể chốt một số nội dung có thể tả về một đồ vật trên sơ đồ 

tư duy, HS có thể dựa vào đó để lựa chọn, mở rộng cho sơ đồ tư duy các em vẽ. 

 
 

- Khi HS đã có những nội dung cụ thể sẽ tả về đồ vật của các em, GV cho 

HS nhắc lại 5 bước vẽ sơ đồ tư duy đã học: 

+ Bước 1. Xác định chủ đề 

+ Bước 2. Vẽ chủ đề ở phần trung tâm 

+ Bước 3. Vẽ thêm các tiêu đề phụ (nhánh cấp 1) 
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+ Bước 4. Vẽ các nhánh phụ (nhánh cấp 2, cấp 3) 

+ Bước 5. Thêm các hình ảnh minh họa 

- GV tổ chức cho HS vẽ sơ đồ tư duy cho đoạn văn tả đồ vật của các em, 

trong bước này GV hỗ trợ các em hoàn thiện sơ đồ tư duy nhanh và đẹp nhất. 

Hoạt động 3, 4, 5: 

- GV cho một số học sinh trưng bày, trình bày sơ đồ tư duy đồng thời GV 

gợi ý để học sinh chủ động tổ chức cho các bạn nhận xét, góp ý cho sơ đồ tư duy 

của mình. Như vậy HS chủ động hơn, được làm việc nhiều hơn, đồng thời phát 

triển năng lực ngôn ngữ cho các em.  

- Sau khi trao đổi, thảo luận về sơ đồ tư duy đã vẽ, các em hoàn thiện lại sơ 

đồ của mình để chuẩn bị cho bước viết thành đoạn văn ở hoạt động tiếp theo. 

Hoạt động 6:  

- GV tổ chức cho các em dựa vào sơ đồ tư duy viết thành đoạn văn hoàn 

chỉnh. Trước khi viết, GV lưu ý HS khi viết đoạn văn cần chú ý viết từng câu tả đồ 

vật theo từng mục trong sơ đồ tư duy; câu cần rõ ý, nên có hình ảnh so sánh và thể 

hiện sự quan sát tinh tế bằng nhiều giác quan. 

- Tiếp theo GV tổ chức cho HS chia sẻ bài viết theo nhóm. Trong bước này 

GV có thể sử dụng kĩ thuật xích xe tăng rất phù hợp, HS có cơ hội chia sẻ bài viết 

của nhiều bạn trong nhóm một cách khoa học. Trong quá trình chia sẻ GV lưu ý HS 

sửa lỗi và bình chọn bạn có bài viết hay nhất trong nhóm. 

- GV gọi HS có bài viết hay nhất lên chia sẻ, HS khác nhận xét, góp ý chỉnh 

sửa. Trong bước này ngoài việc nhận xét về hình thức trình bày, nội dung, GV nên 

chú trọng, tuyên dương HS có những câu văn có hình ảnh so sánh, nhân hóa. 

5.3. Tổ chức nhận xét, đánh giá sản phẩm học tập của học sinh 

5.3.1. Xây dựng tiêu chí đánh giá 

Sau khi tổ chức cho học sinh xây dựng các sơ đồ tư duy, giáo viên cùng học 

sinh đưa ra các tiêu chí nhận xét, đánh giá. 

Ví dụ: Bài 24. Luyện tập: Viết đoạn văn tả đồ vật (Bài tập 1,2 trang 110, 

SGK, TV3, tập 1). Các tiêu chí nhận xét, đánh giá như sau: 

* Sơ đồ tư duy 

- Sơ đồ đúng chủ đề, đủ ý, sắp xếp ý hợp lí. 

- Lựa chọn từ ngữ ngắn gọn, súc tích. 

- Sơ đồ vẽ hình ảnh phù hợp, màu sắc đẹp. Sơ đồ có tính độc đáo, sáng tạo, 

có nét riêng. 
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* Đoạn văn 

Dựa trên sơ đồ, học sinh hoàn thiện viết đoạn văn hoàn chỉnh. HS, giáo viên 

nhận xét, đánh giá dựa trên các tiêu chí cụ thể.  

Ví dụ: 

- Đoạn văn viết đúng chủ đề, sắp xếp các ý hợp lí. 

- Chọn tả được các đặc điểm nổi bật của đồ vật. 

- Dùng các từ ngữ gợi tả, gợi cảm. Viết câu văn rõ ý, có hình ảnh sinh động. 

5.3.2. Các hình thức đánh giá 

* Học sinh tự đánh giá  

Học sinh tích cực tự nhận xét đánh giá theo hướng dẫn của giáo viên. Học 

sinh tự đánh giá ngay trong quá trình hoặc sau khi thực hiện từng nhiệm vụ học tập, 

báo cáo kết quả với giáo viên. 

Ví dụ: Bài 24. Luyện tập: Viết đoạn văn tả đồ vật (Bài tập 1, trang 110, 

SGK, TV3, tập 1) 

- Giáo viên yêu cầu học sinh lập sơ đồ tư duy, trả lời các câu hỏi bài 1. 

- Sau khi học sinh nêu các ý trong sơ đồ, giáo viên chốt đáp án. 

- GV mở rộng: Ngoài tả các bộ phận và âm thanh các em tả thêm chi tiết nào 

trong sơ đồ của mình? (Học sinh đối chiếu bài của mình đưa thêm chi tiết giới thiệu 

hoặc nêu công dụng của đồng hồ hoặc tự bổ sung các chi tiết ở nhánh câm hay sửa 

các ý chưa đúng). 

* Học sinh đánh giá học sinh (tha  gia nhận xét, góp ý bạn, nhó  bạn) 

Ví dụ: Bài 24. Luyện tập: Viết đoạn văn tả đồ vật (Bài tập 2, trang 110, 

SGK, TV3, tập 1) 

Học sinh tham gia nhận xét, góp ý sản phẩm học tập của bạn, nhóm bạn ngay 

trong quá trình thực hiện các nhiệm vụ học tập, thảo luận, hướng dẫn, giúp đỡ bạn 

hoàn thành nhiệm vụ để học và làm tốt hơn. 

Sau khi giáo viên tổ chức cho học sinh hoàn thành sơ đồ tư duy cá nhân, giáo 

viên cho học sinh đánh giá, nhận xét bài của bạn, chỉ ra các ý hay, từ ngữ phù hợp  

cũng như góp ý sửa lỗi về chính tả, dùng từ đặt câu trong sơ đồ tư duy của mình. Ví 

dụ như bạn dùng từ này chưa hay, bạn có thể thay bằng từ ,… 

* Giáo  iên đánh giá 

Giáo viên sử dụng linh hoạt, phù hợp các phương pháp đánh giá, nhưng chủ 

yếu thông qua lời nói chỉ ra cho học sinh biết được chỗ đúng, chưa đúng và cách 
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sửa chữa; viết nhận xét vào vở hoặc sản phẩm học tập của học sinh khi cần thiết, có 

biện pháp cụ thể giúp đỡ kịp thời. 

Ví dụ: Bài 24. Luyện tập: Viết đoạn văn tả đồ vật (Bài tập 3, trang 110, 

SGK, TV3, tập 1) 

Sau khi học sinh hoàn thành đoạn văn giáo viên nhận xét, ví dụ như:  

+ Đoạn văn viết đúng chủ đề, sắp xếp các ý hợp lí. 

+ Chọn tả được các đặc điểm nổi bật của đồ vật. 

+ Dùng các từ ngữ gợi tả, gợi cảm. Viết câu văn rõ ý, có hình ảnh sinh động. 

Cô khen em, phát huy em nhé! 

* Cha  ẹ học sinh tha  gia đánh giá 

Giáo viên phối hợp và hướng dẫn cha mẹ học sinh tham gia vào quá trình 

đánh giá. Cha mẹ học sinh trao đổi với giáo viên về các nhận xét, đánh giá học sinh 

bằng các hình thức phù hợp và phối hợp với giáo viên động viên, giúp đỡ học sinh 

học tập, rèn luyện. 

Ví dụ: Phần Vận dụng, trải nghiệm  

- GV dặn dò: Về nhà các em hãy quan sát các đồ vật yêu thích của gia đình, 

viết đoạn văn tả về đồ vật đó rồi đọc cho người thân nghe và xin ý kiến nhận xét, 

góp ý của người thân. 

- Trong quá trình trao đổi với cha mẹ học sinh, giáo viên cần phối hợp với 

cha mẹ học sinh trong việc giúp các em vận dụng dùng từ, viết câu, rèn kĩ năng 

nghe, nói trong cuộc sống hàng ngày. Giáo viên gợi ý cho cha mẹ học sinh đánh 

giá, nhận xét đoạn văn của học sinh. 

6. Kết quả thực hiện chuyên đề 

Sau thời gian áp dụng chuyên đề vào thực tế giảng dạy, chúng tôi nhận thấy 

học sinh hào hứng và mạnh dạn hơn trong các giờ học. Các em được thỏa sức sáng 

tạo, thể hiện sự linh hoạt, tự tin các ý tưởng cá nhân. 

Năng lực học tập của học sinh được nâng cao: các em nhớ nhanh, nhớ lâu và 

nhớ một cách có logic các kiến thức. Từ đó, HS biết học những vấn đề trọng tâm, 

biết liên kết các vấn đề, xâu chuỗi thành một hệ thống kiến thức có liên quan đến 

nhau. Các đoạn văn khi các em viết các ý được sắp xếp theo trình tự hợp lý. Khi tái 

hiện các ý các em nhớ lâu, vận dụng lựa chọn từ ngữ, viết câu tốt hơn. 

Học sinh được học qua sơ đồ tư duy bằng các đường nét, hình ảnh, màu sắc 

sinh động sẽ giúp các em dễ nhìn, dễ học. Hơn thế, các em hứng thú chờ đón, yêu 
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thích môn Tiếng Việt nên các em không còn ngại viết văn, không còn tình trạng lệ 

thuộc, sao chép những đoạn văn mẫu.  

Giáo viên trong các khối lớp đã tự tin vận dụng kĩ thuật sơ đồ tư duy vào rất 

nhiều môn học và hoạt động giáo dục. Giáo viên có kĩ năng vẽ sơ đồ nhanh, đẹp, 

góp phần nâng cao hiệu quả giờ dạy. Các thầy cô tổ chức các tiết học một cách nhẹ 

nhàng, tự tin và dành nhiều thời gian cho các em hoạt động thực hành, chia sẻ cùng 

các bạn. 

Với chuyên đề này giáo viên có thể áp dụng với tất cả các khối lớp từ lớp 1 

đến lớp 5. Tuy nhiên giáo viên cần linh hoạt vận dụng cho phù hợp với từng môn, 

từng bài và từng lớp khác nhau nhằm khuyến khích học sinh tích cực học và sáng 

tạo phù hợp với năng lực cá nhân. 

Phương pháp dạy học sử dụng sơ đồ tư duy là một phương pháp dạy học 

đầy sáng tạo, giúp liên kết các kiến thức bằng hình ảnh một cách trực quan, dễ 

hiểu, dễ nhớ. Phương pháp này nên được khuyến khích không chỉ trên lớp mà 

còn ở nhà và phụ huynh hoàn toàn có thể cùng con em ôn tập các kiến thức sau 

những giờ học tại trường. 

Sau khi áp dụng chuyên đề, bước đầu giáo viên và nhà trường đã gặt hái 

được những thành công đáng mừng song trong quá trình thực hiện, chuyên đề 

không tránh khỏi những hạn chế. Nhà trường chúng tôi rất mong nhận được những 

ý kiến đóng góp, chia sẻ của các bạn đồng nghiệp. 

 

 

 

 

 

 

 

 

 

 

 

 

 



27 

PHẦN 3. KẾT LUẬN, KHUYẾN NGHỊ 

1. Kết luận 

Sử dụng thành thạo, hiệu quả sơ đồ tư duy trong dạy học sẽ mang lại kết quả 

tốt, đáng khích lệ trong quá trình học tập của học sinh và giảng dạy của giáo viên. 

Học sinh sẽ học được phương pháp tự học, tăng tính chủ động, sáng tạo và phát 

triển tư duy. Giáo viên sẽ tiết kiệm được thời gian, tăng sự linh hoạt trong bài 

giảng, và quan trọng nhất sẽ giúp học sinh nắm được kiến thức thông qua một “sơ 

đồ” thể hiện các liên kết chặt chẽ của tri thức.  

Với cách dạy và học này giúp học sinh luôn phải hoạt động, suy nghĩ, tư duy, 

phát hiện ra nội dung trọng tâm cần ghi nhớ và tổng hợp. Học sinh không bị nhàm 

chán trong mỗi giờ học, không bị gò bó học thuộc một cách máy móc. 

Ngoài ra học sinh được rèn luyện kĩ năng đọc (học sinh đọc và ghi nhớ nội 

dung một cách trọng tâm), kĩ năng viết (sắp xếp ý khoa học, ghi nhớ ý nhanh, chính 

xác); kĩ năng nghe (ghi tóm tắt lại ý, kiến thức trọng tâm); kĩ năng nói (xây dựng 

điểm tựa để nói); rèn luyện khả năng tư duy (học sinh sẽ tái hiện lại những nội 

dung đọc thành một chuỗi kiến thức có sự liên kết chặt chẽ về thời gian); phát triển 

khả năng sáng tạo của mỗi học sinh (học sinh thể hiện được các năng khiếu vẽ, 

trang trí, sắp xếp, sử dụng màu sắc…). 

Sau khi áp dụng kĩ thuật dạy học này, chúng tôi nhận thấy trong các tiết học:  

- Giáo viên tự tin đóng vai trò hướng dẫn điều khiển, không “nói nhiều, làm 

việc nhiều” như cách dạy truyền thống. 

- Sử dụng kĩ thuật sơ đồ tư duy, GV có điều kiện nâng cao khả năng ứng 

dụng công nghệ thông tin trong dạy học. 

- Học sinh tập trung cao vào học tập, tích cực, hào hứng, chủ động tiếp thu 

kiến thức. HS nhớ bài nhanh hơn, sâu hơn. 

- Kĩ thuật sơ đồ tư duy giúp học sinh tự tin, phát triển năng lực ngôn ngữ, 

biết diễn đạt quan điểm của bản thân, biết đặt câu hỏi, biết hệ thống, sắp xếp nội 

dung kiến thức đã học. Bên cạnh đó rèn cho học sinh kĩ năng hợp tác, biết chia sẻ, 

hỗ trợ lẫn nhau trong học tập. Biết cùng nhau tổng hợp lại những nội dung kiến 

thức đã học và tìm ra ý chính trong bài. 

2. Khuyến nghị 

2.1. Đối với giáo viên 
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Qua quá trình nghiên cứu, tìm hiểu thực trạng, xây dựng thiết kế bài dạy áp 

dụng kĩ thuật sơ đồ tư duy đạt hiệu quả mỗi giáo viên cần thực hiện tốt các nội 

dung sau: 

Thứ nhất: Xác định đúng nội dung kiến thức và mục tiêu cần đạt trong mỗi 

bài học. 

Thứ hai: Tích cực đổi mới, vận dụng một cách linh hoạt các phương pháp và 

hình thức tổ chức dạy học. Giáo viên phải là người định hướng, hình thành cách 

học cho học sinh, tổ chức các hoạt động học tập để mọi học sinh đều được tham 

gia. 

Thứ ba: Áp dụng những thành tựu của công nghệ thông tin hỗ trợ cho việc 

giảng dạy. Việc sử dụng sơ đồ tư duy trong các hoạt động dạy - học sẽ làm chuyển 

biến thực trạng dạy học hiện nay, khắc phục phần nào lối dạy học truyền thụ một 

chiều. Đồng thời kích thích tính tích cực, độc lập sáng tạo, sự phát triển tư duy trí 

tuệ của học sinh, giúp các em nắm và hiểu chắc kiến thức đã được học góp phần 

thực hiện thành công mục tiêu mỗi tiết học. 

Để mỗi tiết học trở nên sinh động, hấp dẫn, phát huy được tính tích cực, chủ 

động tham gia vào quá trình học tập, kích thích tư duy, sáng tạo và cộng tác làm 

việc của từng em, giáo viên cần căn cứ vào nội dung bài học, điều kiện thực tế của 

nhà trường, đặc điểm tâm sinh lý học sinh lớp mình để lựa chọn các kĩ thuật dạy 

học phù hợp. 

2.2. Đối với nhà trường 

- Quan tâm, hướng dẫn và tập huấn cho giáo viên về đổi mới phương pháp 

dạy học, mạnh dạn áp dụng các kĩ thuật dạy học tích cực triển khai chương trình 

GDPT 2018 hiệu quả. 

- Trân trọng, động viên, khuyến khích và ghi nhận những giáo viên nhiệt 

huyết, mạnh dạn áp dụng cái mới trong quá trình triển khai chương trình. 

2.3. Đối với Phòng Giáo dục & Đào tạo 

- Tích cực tổ chức các chuyên đề, hội thảo tháo gỡ những khó khăn vướng 

mắc trong quá trình triển khai chương trình mới, đồng thời chia sẻ, học hỏi kinh 

nghiệm hướng tới các tiết dạy hay, các chuyên đề thiết thực. Tạo điều kiện cho giáo 

viên các nhà trường được trao đổi, học tập, rút kinh nghiệm. 

- Biểu dương, động viên kịp thời gương những giáo viên nhiệt huyết, mạnh 

dạn áp dụng các “luồng gió mới” và trân trọng những sáng tạo của các nhà trường 

trong quá trình giảng dạy và cống hiến cho ngành. 
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PHỤ LỤC 

KẾ HOẠCH BÀI DẠY  

MÔN TIẾNG VIỆT LỚP 3  

Tuần 13, bài 24: Viết đoạn  ăn tả đồ vật  

(Bộ sách: Kết nối tri thức với cuộc sống) 

1. Yêu cầu cần đạt: Sau bài học, HS đạt được những năng lực, phẩm chất sau: 

1.1. Năng lực đặc thù 

- Năng lực văn học: HS đọc và hiểu được bài văn, tìm được từ ngữ tả các bộ phận, 

âm thanh của cái đồng hồ; nhận biết câu văn có hình ảnh so sánh. 

- Năng lực ngôn ngữ: HS viết được đoạn văn tả đồ vật theo gợi ý. 

1.2. Năng lực chung 

- Năng lực tự chủ, tự học: HS lắng nghe, hoàn thành các yêu cầu của bài học, viết 

bài đúng, kịp thời.  

- Năng lực giải quyết vấn đề và sáng tạo: Trả lời các câu hỏi, vẽ được sơ đồ tư duy. 

- Năng lực giao tiếp và hợp tác: Tham gia làm việc nhóm chủ động, tích cực. 

1.3. Phẩm chất 

- Phẩm chất yêu nước, nhân ái: Biết yêu quý, giữ gìn đồ vật yêu thích, tôn trọng 

bạn trong làm việc nhóm. 

- Phẩm chất chăm chỉ: Chăm chỉ viết bài, tích cực trả lời câu hỏi. 

- Phẩm chất trách nhiệm: Giữ trật tự, học tập nghiêm túc. 

2. Đồ dùng dạy học 

- GV: Slide Powerpoint, tivi, máy tính, phiếu học tập,... 

- HS: SGK, hộp màu, hộp bút, keo dán, đồ vật hoặc tranh vẽ. 

3. Hoạt động dạy học ch  yếu 
 

Hoạt động tổ chức, hướng dẫn c a GV Hoạt động học tập c a HS 

3.1. Khởi động (3 phút) 

* Mục tiêu: Tạo không khí vui vẻ, phấn khởi trước giờ học. 

* Cách tiến hành: 

- Giới thiệu bài: GV dẫn dắt nội dung tuần 

10 giới thiệu bài.  

- Yêu cầu HS mở SGK tr. 110. Ghi bảng  

- HS lắng nghe. 

 

- HS mở SGK. 
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- GV giới thiệu nhân vật đồng hồ. 

 

 

 

- Bài hát nhắc tới đồ vật gì? 

- Chiếc đồng hồ nhắn nhủ các em điều gì? 
 

- GV dẫn dắt sang nội dung khám phá. 

- Nhân vật đồng hồ xuất hiện 

- HS giới thiệu, bắt nhịp các bạn hát  

bài Chiếc đồng hồ của nhạc sĩ Văn 

Nhân. 

- Bài hát nhắc đến chiếc đồng hồ. 

- Chiếc đồng hồ nhắn nhủ chúng em 

học hành chăm chỉ. 

- HS lắng nghe. 

3.2. Khám phá (30 phút) 

* Mục tiêu: 

+ Năng lực văn học: HS đọc và hiểu được bài văn, tìm được các từ ngữ tả các 

bộ phận, âm thanh của cái đồng hồ; nhận biết câu văn có hình ảnh so sánh. 

+ Năng lực ngôn ngữ: Biết viết đoạn văn  tả đồ vật dựa trên sơ đồ tư duy. 

* Cách tiến hành: 

Hoạt động 1: Tì  hiểu bài  ăn Cái đồng 

hồ (12 phút) 

Bài 1a: 

- Gọi học sinh đọc yêu cầu bài tập 1. 

- Gọi 1HS đọc bài cái đồng hồ, lớp đọc 

thầm. 

- Tổ chức cho các em thảo luận cặp đôi, ghi 

câu trả lời vào phiếu học tập. 

- GV đưa phiếu học tập lên màn hình 

- Phiếu học tập của cô được thiết kế dưới 

dạng gì? 

- Giao nhiệm vụ: HS hoàn thành SĐTD 

trong thời gian 2 phút. Trong 2 phút, đội 

nào xong trước sẽ di chuyển lên trưng bày 

trên bảng lớp và ưu tiên 3 nhóm làm nhanh 

nhất được quyền trình bày. 

- Tổ chức cho HS làm việc nhóm. 

- Tổ chức cho các nhóm trình bày, các 

nhóm khác bổ sung ý kiến.  

 

 

 

- 1 HS đọc. 

- 1HS đọc thành tiếng, lớp đọc thầm 

tìm câu trả lời theo yêu cầu. 

- HS theo dõi. 

 

- HS quan sát 

- Phiếu học tập trên có dạng sơ đồ tư 

duy. 

 

- Thực hiện yêu cầu theo cặp đôi. 

 

 

 

- Đại diện HS nhận phiếu, làm bài. 

- Đại diện 1HS trình bày, các nhóm 

nhận xét.  
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- Chốt đáp án. 

- Trong bài văn này, nhà văn Vũ Tú Nam đã 

tập trung miêu tả vỏ đồng hồ, kim đồng hồ, 

ngoài những bộ phận này chúng ta còn có 

thể tả những bộ phận nào khác? 

- GV chốt ý: Để tả một chiếc đồng hồ ta có 

thể tả nhiều bộ phận. 

Bài 1b: Tì  câu  ăn có hình ảnh so sánh 

- GV dẫn dắt: Nhà văn Vũ Tú Nam đã thật 

khéo léo, với sự quan sát tinh tế, tác giả đã 

viết những câu văn rất hay có sử dụng biện 

pháp so sánh. 

- Yêu cầu HS tìm trong bài câu văn có hình 

ảnh so sánh? 

 

 

- Trong câu văn này tiếng chuông đồng hồ 

được so sánh với tiếng gì? 

- Em ấn tượng nhất với từ ngữ nào? 

- Theo em từ ác có nghĩa là gì? 

- GV mở rộng, chốt nghĩa các từ HS chưa 

hiểu rõ nghĩa.  

- Lưu ý HS quan sát, miêu tả có thể vận 

dụng nhiều giác quan để bài viết thêm sinh 

động. 

- Cho HS trải nghiệm tiếng dế. 

- Ngoài câu văn này, bạn nào tìm thêm được 

câu văn khác? 

- Trong câu văn này hai sự vật nào được so 

sánh với nhau? 

- Hiển thị hình ảnh kim đồng hồ sáng như 

đom đóm. 

- Yêu cầu HS đọc câu văn đầu tiên trong bài 

- Theo dõi. 

- HS nêu nối tiếp: Ví dụ tả các chữ 

số, mặt đồng hồ, chuông báo thức.  

 

 

 

 

 

 

- Lắng nghe. 

 
 

- 1HS nêu, HS khác nhận xét. 

Đồng hồ nhà tôi có tiếng chuông reo 

“ác” thật, vang và trong như dế cộ 

gáy sau đêm mưa. 

- Tiếng chuông được so sánh với 

tiếng dế cộ gáy sau đêm mưa. 

- 2 HS nêu, ví dụ ác, dế cộ 

- HS trả lời theo ý hiểu. 

 

- HS lắng nghe, ghi nhớ.  

 

 

 

- HS trải nghiệm, lắng nghe 

- Đặc biệt tối không có đèn, hai cái 

kim của nó ... như đom đóm.  

- Hai cái kim được so sánh với con 

đom đóm. 

- HS quan sát hình ảnh. 

 

- 1HS đọc 
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văn. 

- GV giới thiệu: Đó chính là câu giới thiệu 

về chiếc đồng hồ. 

- Yêu cầu HS đọc câu văn cuối và nêu nội 

dung. 

- Yêu cầu một HS chia sẻ trước lớp cách 

viết đoạn văn tả đồ vật. 

- GV chốt: Những điều mà bạn vừa chia sẻ  

chính là những lưu ý khi viết đoạn văn. 

- Chuyển ý: Dựa vào những chia sẻ của bạn 

và cách hiểu của bản thân, các em hãy lập 

sơ đồ tư duy cho đoạn văn tả đồ vật mà em 

yêu thích và dựa vào đó để viết thành đoạn 

văn thông qua hoạt động tiếp theo. 

Hoạt động 2: Viết đoạn  ăn tả đồ vật (18 

phút) 

- Gọi HS yêu cầu bài tập số 2.  

- GV kiểm tra đồ dùng đã dặn dò tiết học 

trước. 

- Tổ chức cho HS ngồi theo nhóm sở thích. 

- Gọi 1 HS nhắc lại cách viết 1 đoạn văn tả 

đồ vật đã chia sẻ ở bài tập 1. 

- GV chốt: Có thể lập thêm các nhánh phụ 

tả về đặc điểm các bộ phận có tính đặc 

trưng của đồ vật đó. 

- Tổ chức cho HS vẽ sơ đồ, chia sẻ trong 

nhóm. 

- Tổ chức cho HS trưng bày sơ đồ tư duy, 

chữa bài. 

- GV nhận xét chung, lưu ý cho HS: Khi 

viết đoạn văn, các em chú ý viết từng câu tả 

đồ vật theo từng mục trong sơ đồ tư duy, 

câu cần rõ ý, có hình ảnh so sánh. 

- Yêu cầu HS viết đoạn văn vào vở. 

 

 
 

- 1HS đọc và nêu: Câu văn cuối nhà 

văn tả công dụng của cái đồng hồ.  

- 1HS lên chia sẻ. 

 

- HS lắng nghe, theo dõi. 

 

 

 

 

 

 

 

- 1HS đọc yêu cầu. 

- HS báo cáo đồ dùng đã chuẩn bị. 

 

- HS nghe nhạc, di chuyển ngồi theo 

nhóm sở thích. 

- 1HS nhắc lại. 

 

- HS ghi nhớ. 
 

- HS làm việc nhóm 

 

- HS lập sơ đồ 

- 2 - 3HS trình bày, lớp nhận xét, 

góp ý. 

- Ghi nhớ. 

 

- HS viết bài. 
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- GV quan sát, hỗ trợ. 

- GV tổ chức cho HS chia sẻ bài viết trong 

nhóm theo kĩ thuật Xích xe tăng. 

- Yêu cầu các nhóm báo cáo bạn viết hay 

nhất và bài viết cần góp ý? 

- Chiếu một số bài viết của HS, tổ chức cho 

lớp nhận xét, góp ý. 

- GV gợi mở nhân hóa( nếu có) sẽ được tìm 

hiểu ở lớp 4. 

- GV nhận xét chung, tuyên dương HS. 

 

- HS chia sẻ trong nhóm 4. 

 

- HS báo cáo. 
 

- HS nêu bài làm, điều hành các bạn 

góp ý. HS đọc bài, góp ý cho bạn. 

- HS ghi nhớ. 

3.3. Vận dụng (3 - 5 phút) 

* Mục tiêu: 

+ Củng cố những kiến thức trong tiết học để học sinh khắc sâu nội dung. 

+ Vận dụng kiến thức đã học vào thực tiễn. 

+ Tạo không khí vui vẻ, hào hứng, lưu luyến sau khi học sinh bài học. 

+ Phát triển năng lực ngôn ngữ. 

* Cách tiến hành: 

TRÒ CHƠI: HỘP QUÀ BÍ MẬT 

- GV hướng dẫn cách tổ chức trò chơi. 

- GV nhận xét, đánh giá. 

- GV chốt: Qua trò chơi các em thấy khi 

cảm nhận về đồ vật, muốn chính xác, thì 

chúng ta cần dựa vào các đặc điểm của đồ 

vật và sử dụng nhiều giác quan. 

- GV dặn dò HS quan sát các đồ vật yêu 

thích của gia đình, viết đoạn văn tả về đồ 

vật đó rồi đọc cho người thân nghe và xin ý 

kiến nhận xét, góp ý của người thân. 

 

- 1HS tổ chức cho các bạn tham gia. 

- HS đánh giá. 

- HS lắng nghe, về nhà thực hiện. 

 

 

 

 

 

- HS lắng nghe, về nhà thực hiện. 

4. Điều chỉnh sau bài dạy 

Căn cứ vào thời gian thực tế của tiết học, giáo viên có thể hướng HS mở rộng các ý 

từ các nhánh câm trên sơ đồ. 

_____________________________________________ 


